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1 INTRODUCTION

1.1 What is Xiino?

Xiino is a web browser for the Palm OS. When your Palm™ device is connected to the Internet,
you can browse a website or download information.

Browsing Various Web Sites with ease...

When you browse a website that was created for viewing on a desktop PC, Xiino automatically
converts the text layout and picture size to fit the Palm device screen. Xiino makes web browsing
with Palm device almost as good as doing it on computers in your home and office.

Useful functions to reduce communication time...

Xiino features offline browsing which enables you to access a web page saved in the Palm™
device internal cache even when you are not connected to the Internet. Xiino’'s automatic cruise
function downloads a pre-specified web page and saves it to the Palm™ device internal cache.
These functions facilitate operations and reduce communication time.

1.2 Before Using Xiino

This manual is for Xiino 1.0 beta English language version. Xiino is a web browser for the
Palm™ device. Please refer to the operation manual of your Palm™ device for details on how to
connect your Palm™ device to communication tools, such as modem, installation of application
software, and Internet connection configurations.

1.2.1 Warning, Caution and Limitations

Warning: Please read the End User License Agreement

Before using Xiino, please read the End User License Agreement for all software. After
consenting to the clauses of the Agreement, install all software. The End User License
Agreement is included at the end of this manual.

Caution
e The copyright of this manual belongs to ILINX, Inc.
e Copy of this software or manual in whole or in part is forbidden.
e The software and manual can be changed without prior notice.
e We do not take any responsibility for the results of using the software and manual.

Limitations

You may encounter that the Channel options on Xiino. However, these are not available in the
English version yet. These functions are available the Japanese version (The English version
has been modeled after the Japanese version).

Trademark

Palm, HotSync are trademarks of Palm Computing, Inc. or its subsidiary and PalmOS is a
trademark of Palm, Inc. or its subsidiary.

Other brands and product names maybe trademarks of each owner.
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1.2.2 Terminology

Ciripe U rwe M

Palm 05 Emiilales

Horre| Dugze

Bwrad BuEze —

Tap

To touch the screen with the Stylus tip
momentarily is called “tap”. Tap to Set/
Select operations.

Drag

To draw the Stylus tip along the screen
slowly is called drag. You drag to Move an
item on the screen.

Drop-Down Menu

An item with a down arrow on the left is
called a Drop-Down Menu. When you tap
the down arrow, a menu appears.

Check Box

The box displayed for selecting an item on
the setting screen is called a Check Box.
When you tap the Check Box, a check mark
appears in the box which means that the
item is selected.

Selection Box or Box

The dotted-line frame displayed for selecting
an item on setting screens is called a

Xiino 1.0 English User Manual
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Selection Box or Box. When you tap the
box, the screen is switched or the box turns
blue. When the box is blue, it means that
the item is selected.

Scroll Button

The buttons vertically aligned at the lower
part of the Palm™ device are called Scroll
Buttons. You use these buttons to move the
cursor or to scroll the screen.

[Menu] Button

The button to display application menu,
[Menu] button, is on the lower left corner of
the screen. By tapping the [Menu] button, a
menu appears on the upper portion of the
screen.

[Home] Button

The button to display the [Application
Startup] screen, the [Home] button, is on the
lower left corner of the screen. By tapping
the [Home] button, the [Application Startup]
screen appear.

© 2002 ILINX, Inc.



2 SETUP GUIDE
2.1 Before Installing Xiino

2.1.1 Memory Requirement

To install Xiino requires at least 550Kb of free memory capacity. To check how much memory
your handheld has, from the [Home] screen, select [Info...] option from [App] menu. Tap [Size]
button, and you will see how much memory is left on your handheld. Remove unnecessary
application software and data in order to ensure memory availability to install Xiino.

2.1.2 Xiino Converter (for converting from Palmscape to Xiino)

For those who have Palmscape installed in handheld, it is important to note that PALMSCAPE
AND XIINO CANNOT BE INSTALLED IN THE HANDHELD AT THE SAME TIME. BEFORE
YOU INSTALL XINO, YOU NEED TO LAUNCH XIINO CONVERTER. PLEASE SEE THE
FIGURE BELOW FOR THE METHOD OF PROCEEDING TO INSTALL XIINO..

2.2 Installing Xiino

Xiino is a web browser application software which operates on Palm Powered handhelds to which
Palm OS 3.5 and Palm OS 4.x.

Xiino is not installed in the Palm device that you have purchased. To use Xiino, please refer to
the [Readme] text file to install Xiino.prc application software.

If you have already installed Palmscape in your handhelds, you can convert all Palmscape
Bookmarks and Palmscape Cache into Xiino Bookmarks and Xiino Cache.

There are several ways to install depending if you wish to keep the Palmscape data or not.
Please refer to the following:

Palmscape installed? YES Convert Data? YES—— Proceed to Method 1

NO NJO
Proceed to Method 3 Proceed to Method 2

Warning: You cannot use both Xiino and Palmscape on the same Palm OS handheld devices. If
you install both of them on the same Palm devices, and when you uninstall Palmscape from the
HOME screen, Xiino will be uninstalled at the same time. Please use Xiino Converter to uninstall
Palmscape.

YOU CANNOT TRANSFER THE CONVERTED XIINO DATA INTO PALMSCAPE.

Xiino 1.0 English User Manual 6
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Method 1

With the following steps, Palmscape Bookmarks and Palmscape Cache are converted into Xiino

Bookmark and Xiino Cache at the same time, and Palmscape application will be uninstalled.

1. |Install Xiino Converter (XiinoConv.prc) into the Palm handheld by HotSync

2. Launch Xiino Converter.

3. Set Convert on “Internal and check Uninstall Palmscape.

4. When you tap Update, this will convert Palmscape Bookmark and Palmscape Cache into
Xiino Bookmark and Xiino Cache, and also uninstall Palmscape and return to HOME screen.

4:21 prn [I====] - Al
@ 1
Hot5yno Tlail Merno Pad

@ @&

Mote Pad  Palmzcape

& ©

Securit T D List
ﬁ*@
Hiino Cony

Prefs

J

Welcorne

5. Install Xiino (Xiino.prc) into the Palm handheld by HotSync.

Meth

_I_/

od 2

Xiino Converter

hiz application updates docu-
ents cached by Palmnscape 3.1
o Xiino format.
To update the documents,
kelect storage and tap the
Lpdate button.

Internal: [N GNE

Lninstall Palmscape: #

Update

Tololist  Welcorne  ®iino Cony »

Uninstall Palmscape from HOME screen (Automatically, Palmscape Bookmark and Palmscape

Cache will be deleted)

1. Tap on HOME at the left bottom of Palm devices, it shows you HOME screen

2. Tap on Menu at the left bottom of Palm screen and select App -> Delete...

3. Select Palmscape and Internet from Delete dialog and tap on Delete... button. Consequently
Palmscape and Internet will be uninstalled and automatically, Palmscape Bookmark and
Palmscape Cache will be deleted at the same time.

4. Tap Done button and return to HOME

5. Install Xiino (Xiino.prc) on your Palm handheld by HotSync.

BT Options
Delete.. <D
Beam... B
Category.. /Y
Info.. <1

Copy...

-
Clack Crate Book

@ ©

HatSwnc Tlail

g @&

Mote Pad  Palmzcape

o

Card Info

O

Expense
Mlerno Pad

Prefs

|

Delete From: » Handheld
Free Space: 7. 40 of 7. 71

m

Internet K
Palmscape 302K

Method 3
Since Palmscape is not installed, it is not necessary to uninstall Palmscape. You may install

Xiino.

1. Install Xiino (Xiino.prc) on your Palm handheld by HotSync
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2.3 Starting Xiino

To start up Xiino, tap the [Home] button on
the Palm device to view the [Application
Launcher] screen. By tapping the [Xiino]
icon, the Xiino startup screen appears.

2.3.1 Registration

Application Launcher

1128 0 =)

+ Al

Clack

[rate Book

4 Tlail
d Frefs

D 1

Expenze

wiino lcan

When Xiino is launched from the [Application] screen for the first time, the [Registration] dialog
appears. This dialog also appears during the first 30 DAYS from initial installation of Xiino.

Once you have purchased Xiino, you will receive a Registration code. Enter this code into the

[Reg. Code] field.

If you are evaluating Xiino at this time, tap the [CANCEL] button and you will be lead to the Xiino
main screen. Note that evaluation is for a period of two weeks.

2.4 Basic Screens

2.4.1 Browse Screen

The browse screen displays web pages.
The Browse icons displayed at the lower
part of the screen are used to perform the
main operations such as displaying web
pages.

The Browse icons may vary depending on
the communication status.

2.4.2 Selection Screen

Xiino 1.0 English User Manual
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hitp:/hwwwilime.co.jplen/

Sel [ i
Lei‘-":ﬂ [ Q1[0 Df% Browese icons

I
[Select] icon

[Phone] icon

Tapping the [Select] icon on the [Browse]
mode brings you to the [Selection] mode.
This mode is for managing data stored in the
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Palm device internal cache, such as
[Bookmark], [File] and [History].

ILINX, Inc_
Xiino: Select
Eookrmarks: = All m

ILIME, Tnc, el

Tap atagto
change the list.

[Cloze ) (URL. 1 (Mew.] Polg

2.4.3 Preference Dialog Screen

Xiino Prefs a

Encoding: + YWestern a

Cache Size: 200KE o

Proxy: O http: O i
Host:proxy.nowhere.org

Select [Prefs...] in the [Options] menu to  Por:2020
open [Prefs dialog]. This dialog is for Misc.- ) -
configuring Xiino. Notice that there are 3 Timezone: +0000

Show Tips: = -0

v @
I QK11 Cancel 249 ¢
I K Cancel feT] @

pages.

m

2.4.4 Connect/Disconnect Dialog

Tapping the [Phone] icon on [Browse] mode opens the [Connect/Disconnect] dialog.
This screen is for connecting and disconnecting the network.

@ Would you like to @ Would you like to
connect ¥ disconnect ¥
Connect Dialog Dizconnect Dialog

2.45 Menu Bar

From the Browse screen, tap the [Menu] button to display the menus.
(1) Page: Functions for pages
(2) Edit: Text control
(3) Option: Setup menu for Xiino

[picture]

25 Setting Xiino Functions

The [Prefs] dialogs are used to perform the connection settings for the Internet and the basic
settings for displaying web pages.

Xiino 1.0 English User Manual
© 2002 ILINX, Inc.



Prefs Dialog — Part 1

To open the Prefs dialog, tap the [Menu] button of the Palm device and the select [Prefs...] from

the [Options] menu.

Page Edit mm

Font |
-]
Go to loph| Prefs.

Connection.___
Metwork
Internet._.

Epn
Content Service._.
| About Xiino
hittp:/ el co. plend
Select || 4w nlgr: L'Q

(1) Encoding (Text Code)

Selects the language for displaying a web
page. For example, to display web pages in
German, select [Western].

(2) Cache Size

Sets the cache size for storing web page
data.

(3) Proxy

When the proxy is set, web pages are
displayed faster. To use proxy, check the

Prefs Dialog — Part 2

iy —1 Encoding: + YWestern
(2] — Cache Size:  200KE 3
(31 —Proxy:0O htp: O fip
Host:proxy.nowhere.org
Port: 5030
Mlisc -
(41— Tirnezone: +HI000 &

- Xiino Prefs a

(51— Show Tips: B

1 %
[Prefz] Dialog - Part 1

type of proxy (http or ftp) designated by your
provider and enter the host address. The
port number is normally set to [8080].

(4) Timezone

Set the timezone where you are located.
For example, the timezone in Japan is
+0900.

(5) Show Tips

When an icon or link is tapped, its
description pops up.

To open the Prefs dialog, tap the [Menu] button of the Palm device and the select [Prefs...] from

the [Options] menu.

[ S —

o to lopy| Prefs...

Connection...
Metwork
Internet.__

EpgE
Content Service.___
| About Xiino
http:/wwweiliny. co.jplen/
N0 |

Select [ (7] 4an

(1) Load Images
If [When Requested], is selected, Xiino
displays web pages without graphic images,
which results in reducing communication
time.
e Always
Always displays graphic images in
web pages.
e When Requested
Displays text data on the web page
without graphic images. When you
select [Load Images] in [Page]

(17 — Load Irnages: w Always
(27— Server:pdzilin:.co.jp
(3 — Security:

(41— SYDisconnect Afterwards: [

Xiino Prefs a

Cookies: w Accept
Script: w Use
Local: w Confirm User

(=)

Check Updates: w Everytime

203 W

[Prefs] Dialog - Part2

menu from the Xiino screen, the

graphic images will load.
(2) (Image) Server
Enter the image proxy server here which is
pds.ilinx.co.jp. Check the information on
ILINX’s support page at
http://www.ilinx.co.jp/en/ if you problem with
the image proxy server.
(3) Security
Xiino has a security function that determines
the possibility of danger from a network
point of view and displays a warning
message before accepting cookes issued by

Xiino 1.0 English User Manual 10
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Web sites or before downloading files from
the web. Use the Security Settings dialog
box to set the appearance of the warning
display and to execute or suspend process.

(4) Sync

Sets the range for automatic cruise.
e Queued Requests
Updates the cache data specified
for action of Sync.
e Queued Requests & Sync
Updates the bookmark and cache
data specified for action of Sync.

(5) Disconnect Afterwards

Settings and Security Level

If this option is checked, the Internet
connection is disconnected after Sync

action.

(6) Check Updates

Sets the intial URL location to be accessed
while loading a web page when online.

e Everytime

Always access the web server and
download the latest web page.

e Use Cache

Displays first any old web data that
is still stored in [Cache]. If there is
no old web data in [Cache], the web
server is accessed to download the
latest web page.

Security Level

Updated Items Action Warning Safe Safer
Accept Confirm User Reject
Cooki Accept Accepts cookie Confirms users to Does not accept
ookies ; . . D .
Cookies | automatically without | accept cookie with cookie.
warning. warning.
Use Do Not Use
Script Execute Warning message o
Script displayed before Script is not executed.
script is executed.
Execute Confirm User Reject
Local Download | Automatically Confirms users by Does not allow file
files download files without | showing warning downloads.
warning. whether to download
Scripts

Scripts function is supported in Xiino. The type of script is Javascript. When a website is
acccessed with Javascript feature, the status in the bottom of the screen will indicate “Executing

Script...”

Prefs Dialog — Part 3
To open the Prefs dialog (Part 3), the [Menu] button of the Palm device and the select [Prefs...]

from the [Options] menu, and tap the bottom right triangle till you reach 3/3.

Xiino 1.0 English User Manual
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Page Edit :ﬂm Xiino Prefs a8
Eont | | (11 — Certificates:
Ga to lapk| Prefs.
Connection__.
Metwork .
Eg R Internet. ..
Content Service...
| About Xiine (2)— (Delete..)
(3]

http:/fwwweilinec.co.jplend g

3 W
Salect | |¢u n | [ |r,;;.tg

[Pretfs] Dialog - Part 3

(1) Certificates

Lists the installed Certificates

(2) [Delete...] button

To delete a certificate from the list, tap on the certificate name, and then tap [Delete...]
(3) [Show...] button

Displays the Certificate information from the list.

Font Size Configuration
You may select the font size of the web site that you view.

Font__. K
i3 1o Jap. a0 to Japanese VMersion == Goto
Connection._.. Enalish Mersion ==
Metwork...
EgNE |Internst.. q L
Content Service._.
| About Xiino (1) — L ront Al
The change will take effect from
http: e ilinx.co.jplen/ ezt download.
= | ok ) [Cancel )
Select | (7] 4an A0l

[Font] Prets Dialog

(1) Font

The font that is highlighted is the size of the font that is set to view the web pages. To choose
another font size, tap the one that is not highlighted. Tap [OK] to take the settings into effect.
Tap the reload key to view the font size that has been changed.

View the difference of fonts

Al [Small x Large] selected [Large x Large] selected

pize=1abcdef12345 1l Eize=1 abcdef12345

Fize=2 abcdef12345 [.

kize=1 abedef 12345 plze=2 abcdef12345

kize=4 abcdef12345 Eize=3 abodef12345

kize=C abcdef12345 Eize=d abcdef12345

pize=t abcclefl 2345 bize=5 abcdef12345

Fize=7 abedef 12345 bize=h abcdef12345

iza=+1 abcdefl2345 Fize=7 abedef12345

Fize=+Z2 abcde 12345

kize=+3 ghedafl 2245 Z bire=4+1 abcdef12345

Select [ A0l Select [ ] N0 Fla
Xiino 1.0 English User Manual 12
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2.6 Other Settings

Settings for Internet Connection

To setup for dialup Internet connection, there are two places where you need to make the

configuration — [Connection...] and [Network...] — which are found in the [Options] menu from the

browser. [Connection...] contains modem setup, while [Network] contains the Internet dialup

setup. Contact your Internet Service Provider or Carrier for further specific information on how to

set up the dialup information

Page Edit mm

Font___
G0 to lopi| Frefs..

[ Connection...
Metwork .

Internet._..

Egn
Content Service._.
| About Xiino

hitp:/fwwwilinec.co.jplend

b

Select [ an

A0l

.Preferem:es Connection

Available Connections:

CradlesCable

IR ta PC/Handheld
IR ta Phone

Serial ta Phone
Serial ta Modern

[ Done | [Mew..] [ Edit.. ] [ Delete ]

Preferences Metwark

w Service: ATET WorldMet

LUser Marne: usernamedworldn
etgttnet

Password: |

Connection:

| Cone | [ Details.. ][ Connect ]

Handler Setup

To setup applications that are called from Xiino can be found in the [Handler] setup dialog.
example, if Xiino calls for mailto: application, you can set the mailer to the desired application.

From Xiino, select [Internet...] from the [Options] menu.

1. Tap menu, and select [Internet...] from the [Options] menu.

For

2. From the [Internet...] screen, the setup of handlers are displayed. To change the

handler setup, tap on a URL application from the [URL Application] box. The

[Select Application] dialog pops up. Select the appropriate handler which is

supported by Xiino.

3. Tap the [OK] button, and tap [DONE] to take the settings into effect.

Font___
Gn to lopg| Prefs...

Connection._..
Metwork .
Internet.___

AEgn
Content Service_..
| About Xiino
hittp:fwweeiline.co. jplend
Select | |fu A | ] |r',;:.i.'ﬂ

Xiino 1.0 English User Manual
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Preferences Internet Preferences Internet
LRL Applications: URL Applications:
Ihttp wiina [r http wiira
fip BT fip Hiino
res Hiino res Hiino
Select Application
. Select Application for http
Custom:
usTom URLs:
wiing .
........... - Hiino
ore )

Xiino 1.0 English User Manual
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3 WEBSITE BROWSING

3.1 Online Browsing

To view homepages on Xiino, it is necessary to establish an Internet connection. The following

illustrates on how to open and view the ILINX homepage.

3.1.1 Connecting to an Internet Provider
Tap the [Phone] icon & from [Browse] mode to open the [Connection] dialog.

By tapping the [Connect] button, this will begin establishing connection to your Internet Service
Provider. Then the [Browse] screen reappears. The [Phone] icon is displayed as La when the

connection is successfully established.
By tapping the Sync button %=, the line will be connected to the Internet provider and the

automatic sync function will start.

x@o

Version 1.0E
Build 2001-0509-12

1999-2001 ILINX, Inc.

e AR AT A ek o Ml

Salect all FEE;

When there is no connection...

{3} Would you like to
connect?

|

BT —
1

Tap [Cancel] to cancel
Irternet connection, and
return ta the [Brovwse]
SCHEEn.

Tap [OK] to connect

Confirm the following when a connection has failed
® Modem Setup: [Menu] -> [Option] -> [Connection]
® ISP Setup: [Menu] -> [Option] -> [Network]
® Xiino Setup: [Menu] -> [Option] -> [Prefs]
® Modem, telephone line connection, device hardware

3.1.2 Viewing a Web Page
Open ILINX's homepage.

When you select [About Xiino] from the [Options] menu, the Xiino startup screen appears. By

ta the Internet.

tapping the [ILINX Homepage] link on the upper right side of the screen, this will bring you to the

ILINX homepage.

1

o to Japanese \ersion ==

{2

ilinx/&

httE:.f.-’www.ilinx.m.'E.-’en.f

P Mews
P Products

5e||e-:t | I |¢u I | ] |r|,3t
(3 4 5 (67 (71 (3
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(1) Title

Title of the web page displayed on the screen.

(2) Hyperlinked Text

Text that are underlined are hyperlinked text.
When you tap here, the specified web page is
opened.

(3) [Select] button

Opens the [Selection] mode

(4) [Stop] button

Stops the download of a web page.

3.1.3 Using the [Browse] buttons

(5) [Browse] buttons

Controls the displays of the web pages.

(6) [Page Info] icon

Displays information about the web page
including URL and size.

(7) [Sync] button

Connects to the Internet and begins
downloading web pages in sync mode.

(8) [Phone] icon

Connects to / Disconnects from the Internet.

Xiino saves web pages that you have accessed in cache. The sequence in which the pages were
displayed is recorded in the [History] log. You can use the [Browse] buttons to display the
[Cache] data in the sequence recorded in the [History] log.

o to lapanese Mersion ==

R
Hlinx/
httE:Nwww.ilinx.m. 'E.fen.f

P News
P Products |

—

Select [ [ 40 n]ﬁ'r,;:.tﬂ

|
Brovyze buttons

3.1.4 Opening a Web Site

4 Back
Displays the previous page

¥ Forward
Displays the following page recorded in the
[History] log.

A1 Reload
Displays the page again.

When you tap an underlined text, or picture set for hyperlink, the specified page is opened.

URL of an HTML document .html or .htm Displays web pages
Downloads programs and
URL of a program -pre, .pdb installs into Palm device

3.1.5 Choosing Context Menu

The context menu pops up when a hyperlink is tapped in a single period for more than four
seconds. The message varies in the type of contents from the hyperlink.

o to lapanese Mersion == I

P News
F Products
Select [ (2] 40

1
Context Menu

[DFota |
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3.1.6 Inputting URL

To input the URL so as to view web pages, tap [Select] from the [Browse] screen. Then, tap
[URL] which will open a new dialog screen [Open URL]. Enter the URL in this dialog screen. The

symbol [S] stands for shortcut. Tap on [S] and you will see a list of shortcut items such as [.com]
and [index.html].

ILINX, Inc.
Xiino: Select a

Bookrnarks: = All ch Filev|His
ILINA, Irc. i

Open URL
URL:httpsy

4 Oéen ol &

[Open URL] dialog

[ Close I LEL... I Mew..] Polg

3.1.7 Opening a Page Created by Frames

Some websites on a PC have a list of menus on the left side of the window. And the
corresponding information on the right side of the window changes in accordance with the
selected menu. The method to divide a window into the units is called “frames” and then displays
different information in each frame is called “frame display”. The frames are displayed in
separate pages due to limitation of the screen.

Switching the Frame Display

1. The [Frame Icon] appears on the upper right corner of the [Browse] screen when you access
a frame display page.

2. When you tap the [Frame Icon], the [Frame Image] window opens and then displays a
framed graphic as divided on the PC window.

3. The shaded area is the corresponding frame that is currently displayed on the screen. To
switch to other frames, tap the desired white portion.

m L Woeloame Cghici [ r—
S Varrios ey Yerssn Metcome 1o TWICE i
L m L L SnLEaTE Fiek cma Cwber msmbarc Tor veur
bk e i TS aleesmis 5o THES fres inelie THICE dase lar the
g riira ok of Kardh 19955, vou cam
FICS FPF Canfiguratian [R5 P Ceniguren pricey THAS imlsma® Servcaratna
TS Halp IS Halp prigotien
=R P turas
[ N QOO B R T R G STHES Pricie
af v 1] S 10 imlh 10
THEE
— - -l
TN [ [ SR ] LT S [D]4 3 AU s E [ S 1) L
Frams | Sl Pae Frame 2

3.1.8 Opening an SSL website

With SSL (Secure Sockets Layer), data transfer and accessing websites via Xiino ensures high
security.

Communication is done by using the data enciphered between the Web sites which coped with
Xiino and SSL so that the third person couldn't decode contents of communication.

Accessing SSL websites via Xiino uses data encryption method which makes it impossible for
third party to decode contents during data transmission.
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For example, SSL is implemented when credit m =%

card number is entered for online shopping.

1. Open an SSL website fan.10 lapanese Yersion o

2. You will notice that it is an SSL website I
when the [LOCK] icon appears on the Illnxm

upper right hand of the screen.
httE:Kwaw.ilinx.co.':E.fen.-"

b News .
P Mroducts &
Select [ 4an a0l

3.1.9 Change of Icon Displays

The icons to be displayed at the lower part of the browser screen change in accordance with the
communication status.

Offline Status Select [ 4 vl QY[ B
Displayed in gray (when disabled)

Y Displays the history log.
(If there is no log record, these arrow symbols are displayed in gray and
browsing is disabled)

- Offline status.

Download Select [@ 10706 botes.. _ _ _

Status

@ Download is cancelled when this icon is tapped.
10756 bytes.. Displays the history log.

(If there is no log record, these arrow symbols are displayed in gray and
browsing is disabled)

Ca Online status.

Online Status Select [ )] € 00 J1| 0 0o Can
Displayed in gray (when disabled)

T Displays the history log.

(If there is no log record, these arrow symbols are displayed in gray and
browsing is disabled)

Ca Online status.

3.1.10 Disconnecting the Communication Line

Tap the [Phone] icon La from the [Browse] screen which will display the [Connection] dialog.
When you tap the [OK] button, the communication line is disconnected and then the [Browse]
mode reappears and the [Phone] icon appears as &'.

Would you like to
disconnect ¥

3.2 Offline Browsing

Xiino allows you to browse web pages using data stored in [Cache] even when the Palm device is
in offline status (not connected to the Internet).
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If you try to open a web page that does not have its data stored Retrieval Method

in [Cache], the [Retrieval Method] dialog will open. You can ® Requested document
use this dialog to specify automatic data download to [Cache], does not exist in cache.
to be performed when you connect to the Internet the next :';::L"cz';“d;"}“;";
time. retrieve it?

[ o :] [On Mext Swnc :] [Cuncel :]

3.2.1 Cacheand Log

Xiino stores the pages you have browsed to your Palm device’s internal cache as [Cache] data.
It also records the sequence of pages you browsed as [History] log data.

ILINX, Inc.

G ta ) Version > Xiino: Select a Tap [File]
DGI;:'t;ESSﬁ:ﬁ.\,;::i:;:}} Eookrnarks w| Ch|File: » C-:lu:he—|-H_iA:-[— to display
............. a- [Cache]
agn
III"IE (D —Lm e, J O _
inter.ne O (21 Cache icon
. it ; Palrn Infocenter.com -The late.. [J
http:ss line o, ipdeng
DRI IR B Palrn ©5: More Applications, M. [J Cache! list
. Palrn, Inc. Products, Services & [J [Cache] I
F News Yelcorme ta Falmaear.conn! 0
P Mroducts Ed J— ] Filt
Select [[71] 4an N0l £L) i ] [519 gBY e
[Select] Screen - Cache list

1. Title

Data name of [Cache]. If you tap the title when you are in offline mode, and if there is data in
[Cache], the [Browse] mode reappears and the corresponding web page is displayed. If there is
no data in [Cache], the [Retrieval Method] dialog opens.

2. Cachelcon

Displays the [Cache] status and result of the [Sync] function. When you tap this icon, detailed
information about the data is displayed in the [About This Page] dialog.

Cache lcons
The document icon is different depending on the [Cache] status and result of [Sync] function.

Document Icon Description [Cache]
O Page stored in cache Yes

a Page set with Lock Function Yes

[ Page already updated but unread Yes
Page with update requested Yes

No icon Page not stored in cache No

Filter Function

The [Cache] list displays a list of data shown with a specific [Document] icon. The data shown
with the [Document] icons in reverse video (white on black background) at the bottom of the
screen are displayed in the list. When you tap a [Document] icon in reverse video, this icon is
displayed in normal video (black on white background) and the data corresponding to this
[Document] icon is not displayed in the list.

E

i
White Background: Indicates not to dizplay tems

Black Background: Indicates to dipslay tems
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History Logs
To view the [History] log data, tap [Select] button and then, tap the [History] tab. The [History] log
data is displayed according to the sequence when browsing the web pages.

1. Title ILINX, Inc.
The title is the data name of the [History] log.

Xiino: Select

When you tap the title, and if there is [Cache] [Eookrmarks w|thannel|Filew| History

in offline mode, the [Browse] screen {Tr—[finx Faimware O
reappears and the corresponding web page is 404 Mot Found 0
displayed. If there is no data in [Cache], then ﬁiun';f'l;f;rz“epuge E——@}

the [Download] dialog is opened.
2. Document Icon
This displays the [Cache] status. When you

tap this icon, the detailed information about (Tiose) (DAL ) r-o
the data is displayed in the [About This Page] = e
dialog.

3.2.2 Browsing with the Browse Buttons

You can display the [Cache] data using the browse buttons corresponding to the [History] log
sequence.

4 Back: Displays the previous [History] log. =
" Forward:  Displays the next [History] log. | Select [ )] dan v r
A Reload: Reloads the [Cache] data.

3.2.3 Browsing from the [Selection Screen]
Tap [Select] mode and either select [Cache] from the [File] tab or [History] log tab to display the
list of data.

If you tap the title of a page with D& B the [Browse] mode display reappears and the data is
displayed.
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4 USERFUL FUNCTIONS FOR EASY WEB BROWSING

4.1 Bookmark

4.1.1 Whatis a Bookmark?

Bookmark is a function for saving the URL of a web site. Once you have bookmarked a URL, you
can browse the corresponding web page by simply tapping this title on the [Bookmark] list without

entering the URL.

Viewing the Bookmark List

Tap [Select] button and then tap the [Bookmark] tab. Select the desired category from the
dropdown menu of the [Bookmark] tab. A list of bookmarks in the selected category will appear
starting from the newest data in the order of registration.

ilinx. HnmePuge

ilink. HomeFage

Xiino: Select a

astup date-2000.6.22 ‘

ilinx/2s

B krnarks: =——chifiew{Hisly— [Bookmark] tab

ilinz= | Palrwar e S

Document lcor

| Pencil lcon

.
alcorne to ILIME hormepage
Falmware
ntornat Cosnmico
|Select X Hl0F-

[Close ) [URL. ] (Mew. ] Fog

Category

Displays category of bookmarks. You can set
up to 15 categories.

Title

Displays the Bookmark title. If you tap the title
when you are online, the [Browse] screen will
reappear and the corresponding web page is
displayed. If you tap the title when you are
offline, the [Download] dialog will open. If
there is a data in [Cache] in offline mode, the
[Browse] screen reappears and the
corresponding web page is displayed. If there
is no data in [Cache], the [Download] dialog is
opened.

[Pencil] Icon

4.1.2 Registering Bookmarks

Indicates the setting of the automatic cruise
function of bookmark. When you tap the
[Pencil] icon,

the [Edit Bookmark] dialog for
information about bookmarks will open.
[Document] Icon

Indicates the bookmark [Cache] status. The
document icon descriptions are the same as
those of [Cache].
[Close] button
Close [Selection]
[Browse] screen.
[URL] button
Opens the [Open URL] dialog
[New] button

Opens the [Edit Bookmark] dialog.

editing

mode and returns to

You can register up to 32,000 bookmark entries. There are three ways to register a bookmark.

1. Registering from the [Edit Bookmark] dialog

2. Registering a web page being displayed

3. Registering a web page from the [History] log

Registering a web page being displayed
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To register a web page currently displayed on [ 22 Edit_Options
[Browse] screen to a bookmark, tap [Add to i Info f’ !
Bookmark...] in the [Page] menu to open the |Lnnd lmng
[Edit Bookmark] dialog. Check the bookmark Add Bookmark... <8
name and URL, and tap the [OK] button. Dol e
Now, the bookmark is registered e
ind._. «F

] Clean Up._. U

Faliware

linv Intornat Saenicra l

Selact & OIS

Registering from the [Edit Bookmark] dialog

Tap [New] while the
[Bookmark] list is displayed

ilink_ HornePage
Xiino: Select ﬂ

iline. HomeFage
Xiino: Select ﬂ

and open the [Edit Eookmarks: = Al Ch[File = [His — - Edit Bookmark a
Bookmark] dialog. Enter a ilir: | Palrware i) Marme: ilin: | Falrware

bookmark name and URL URL: httpsdww dline:.co.jps palmd
and tap [OK]. Now, the
bookmark is registered.

Category: + Unfil=d
Private: [
Sync: O

(Close ) (URL) [ Mew) I i & &

Registering a web page from the [History] log

Tap the [Document] icon while the [History] log list is displayed

to open the [About This Page] dialog. Tap [Add to Bookmark] URL:httpes A lines coind
to open the [Edit Bookmark] dialog. Check the bookmark name )
and the URL and tap the [OK] button. Now, the bookmark is Mime-Type: te:t/him|

registered. Modified:!

Expires:|

[Delete... ) [ Add Bookrnark... |

4.1.3 Editing Bookmarks

The information associated with a bookmark is entered in the [Edit Bookmark] dialog.
To open the [Edit Bookmark] dialog, open [Selection] mode and tap the [Bookmark] tab. Then,
tap the [Pencil] icon of the bookmark you wish to edit.
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ILINX, Inc.
Xiino: Select a
Edit Bookmark a

Marne:|LIMA, Inc.
URL:http fwwwilinz.co jplend

Category: + Unfiled
Private: [J
Sync: O
[ @k ) (Cancel ) [ Delate... ] &

4.1.4 Deleting Bookmarks

To delete a bookmark, open the [Edit Bookmark] dialog and tap [Delete...] to display the [Delete
Bookmark] dialog. Then, tap [OK].

To open the [Edit Bookmark] dialog, open [Selection Mode] and tap the [Bookmark] tab. Then,
tap the [Pencil] icon of the title of a web page you wish to delete.

4.1.5 HotSync Bookmarks

You can transfer Bookmark items from your PC browser into Xiino browser with Xiino Cruiser.
For specific information, please refer to the Xiino Cruiser Manual.

4.2 PC Cruise

4.2.1 Automatic Cruise
Xiino Automatic Cruise allows you to set websites, bookmarks in [Cache] for later download.

Cruise Configuration
Tap on a hypertext link to text when in offline mode. The [Retrieval Method] dialog appears.

|

o to Jopanese Version ==

Retrieval Method

RS
ilinx&d |
httE:.f.-’www.ilinx.m.'E.fen.f

(P News _
P Froducts
Select | ()] nlor. 'ﬂ

@ Requested docurmnent
does not exist in cache.
Would you like to
connect NOW and
retrieveit?

[ Mow ][ ©n Next Sync ] [ Cancel
I I I

I | |
(1 () (3

(1) Now

This option will establish connection to Internet, and download the website.
(2) On Next Sync

This option will download the website during the next time an Internet connection is established.
(3) Cancel

Closes this dialog box.
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ILIMX, Inc.
Xiino: Select ﬂ

|Bu:u:-km-:|rksv Ch(File: » Cache  |His

httpesdwww. palrmgear.corns | Set for later
ILIME, nc. clonenilasc

Palrn, Inc. Products, Services & &

DanEe M

To download the websites set in [Cruise] mode, tap on the [Sync] icon F=,

4.3 Saving Image Files

You can download graphic images viewed from the [Browse mode] screen and view them on a

graphic image viewer called Xiino Album.

1. From [Browse Mode], tap on the graphic image for at least 4 seconds. The context menu
pops up.

2. From the context menu, tap “Save image”, and the “Load Image Dialog” screen appears.

3. From the “Load Image Dialog”, tap OK to save the image. Tap cancel if you do not wish to
save the image, and this will return you to the Browse screen.

0 1o Japanese Version =x

ILINX, Inc.

o to lapanesze Mersion ==

‘20,10 EnQlizh version == & Load hmage
@ Would you like to
download itnage 7
URL:
http/ funmy ilin® co_jp

[ Newg- : :enfimuges!ilinnlngn.gi
P Products
s [0 0 A0 Foia |
T
Context henu

4.4 Xiino and Memo
Xiino allows you to browse data stored in your Palm device and save web pages in Memo.

441 Browse Memo

To display data stored in Memo on [Browse Screen] of Xiino, open [Selection Mode] and tap the
memo title in the [Memo] list of the [File] tab. To display the [Memo] list, open [Selection Mode],
tap the [File] tab, tap the down arrow, and select [Memo].
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ilink. HomePage

ilinx’2|

elcamne ta ILINA hormepage

Falmnware

P
Selact |

,

ilint_ HormnePage
Xiino: Select a

Eookmarks w| ChiFile: w Marmo  [His]

& s Ao

Select [Memo] from
the [File] Tak

memo://Unfiled/4 W _.. [N

. Twpe into wour Desktop software,
Hrop wour handheld into the cradle,

bnd press the HotSyno® button to
rnerna: Fnfiled d YWays to Enter... 4 Title ranster the typed data. 2. Use the
rnernocddUnfiledTownload Free... brscreen keyboard. In the Graffitig
rermo:dCUnfiled Handheld Basics riting area below, tap the dot balow
rnerno SUnfiled /Power Tips 'abe" for the alphabetic keyboard or
P the dot below "123" for the numeric
eyboard. 3. Use the stylus to write
[araffiti characters in the writing
brea. Characters are mainly Uppercas
— E. sinale-stroke lattars, Write letters
foa Calect 3 or-=

4.4.2 Saving Web Pages in Memo

To save a web page in Memo, select [Save as Memo] from the [Page] menu while in [Browse]
mode.

A web page displayed in [Browse] mode is saved in Memo as text without images.

IPuge Edit Options
Info 1
I Load Irnages ~L

Add Boeokrnark. ~B

D

~F
[€lean Up... L

]

Al

Select [Mema] from

ilint_ HormnePage the [File] Tab memo-f fUnfiledsilinge .

Xiino: Select a mttp:s dwwiline.co jpe’ last up date-
Eiookmarks w|ChiFile: w Mérmo  [Hig] pOOD.6.22 Welcomne to ILING

hiornepage Palmware ilin: Internet
merno:/ AUnfiledsd Wavz toEn.. [J Fervice Partners What's Mew? About
rnernod A Unfileds/Download Free... ) linz Infarmation info@ilin:.co.
roermno:SdUnfiledsHandheld Bazics p1995ilin:=,co. { Copywriter /
rnemos FUnfiledsilin: HomeFage —— Title Wlawurni Kaga Designer # Hiroko
rerno:dAnfiled /Fower Tips Mlorita )
.
—

o8 et [ [ 0 Ao R |
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5 DATA MANAGEMENT

5.1 Viewing the Page Information

To view detailed information about a web page displayed on [Browse] screen and data stored in
[Bookmark] and [Cache], display the [About This Page] dialog.

5.1.1 [About This Page] Dialog

To display the [About This Page] dialog, select the option [Info] from the [Page] menu.

You can also display the [About this Page] dialog by opening the [Selection Mode], tapping the

[Bookmark] tab or [History] tab, and then tapping the [Document] icon I on the right side of the

list.

Or, you can display the [About This Page] dialog by opening [Selection Mode], tapping the [File]
tab to select [Cache] option, and then tapping the [Document] icon O on the right side of the list.

ilinz HomePage
Xiino: Select URL: http: Swwwilingscoips
Bookrnarks: = Al Ch|FiIe*'lIr Hiz|
ilinz | Palrmware %@__."‘ Nimne-Type: et il e,
Cached: 8/25/00 256 am
Modified:|
Expires:|
Size (o cl:Unknown £ 8078 boyte:
Lock: ]
[Close JLURL... ] [ Mew.] Fo'E [Delete... ] [Add Bookrark... ]
URL Expires
URL of this page. (You can edit this data.) Indicates the effective period of this page.
Mime-Type Size (o/c)
Type of document this page contains. Amount of data in this page. Indicates the
Cached page size (0) and the amount used in cache
Indicates the date and time at which this page (c).
was downloaded. Lock
Modified If this check box is marked, the page cannot
Indicates the date and time at which this page be deleted from [Cache]

was last updated on the web.

5.2 Card Support
Cache data can be stored in the Card for devices that have Card support.

[ 22T Edit_Options | Welcome to TWICS About This Page
:_nnf:d Images :;:_ Xiino: 'E"E'Et . URL: bt tp:d s wwilines co. iped ens
Eockrnarks wch[File: w Card  [His|
Add Bookmark_.. ~B Mime-Type:te
LI | Mews a Setht..............
Mowve to Card ILIME. IR 7] Cached: 4/23/02 748 am
Copy to Card Welcorne to THICS D Modified:Lnknon................
; S5ave as Memo Expires:
u| Delete... s Size {0k
Find in Documnent ~F Lock: [J
EES
P Products (Move to Cord) (Copy to Cord)
Zalect [0 [ €0 % A0 Fola | re [Delete...) (Add Bookrnark... )
benu Select Screen Abaut This Fage
Save data while web page is displayed
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[[ZTT Edit_Options ILINX, Inc. |

:_nnf:d — 5:_ Xiino: Select
g : Bookmarks | chiFile = card Iml Qo to lopanese Mersion == Qo
Add Bookmnark .. B
Move to Card ha & TH
] ILIM, I, ] I E
| Copy to Card Wealcame ta TWICS [} I I "x :
m5ave a5 Memo
'." Delete . <D httE:Nwww.ilinx.m.':E.fen.-’
Find in Documnent .~ F
P MNEWS : P Maws :
P _Products P Products
— U
SElectl |¢u ||*n||:||r';,tﬂ | o8 SEIEE‘tl |¢" nlDlr-r:'E |
Menu Select Screen
Save from Cache mode to Card
ILINX, Inc.

Xiino: Select

URL: http Swwwilinco.ipsdens

Bookrnarks »|ChFile: w Card i

ILINE | Mews
ILIME, Inc.
Welcarne to TWICS

] -x E

ilinx’&

httE:Kwaw.ilinx.cn.'E.fen.f

Mews "
: F"Odb cis [Mowe to Card] (Copy to Card) ]

b Cloze | [ URL... gt
Select || €0 0 1 [ﬁ]r.;) o [Lelete... ) [Add Bookmark...] =

Select Screen

s

5.3 Memory Management

5.3.1 Clearing the Internal Cache

You can delete all data of Xiino stored in your Palm device. To delete all data at one time, open
the [Clean Up] dialog, specify the deletion conditions, and tap the [Delete] button.

To open the [Clean Up] dialog, select the option [Clean Up...] from the [Page] menu at the
[Browse] screen.

| IGEE LY Edit Options

Markitems to be deleted:

Channel: RN Al |
Cache: IR Mot Locked [ Al ]

History: [[ETY All |

Cookies: [IEEN Al |

You can delete three types of data — [Cache], [History] and [Cookies]. Tap the delete conditions
for each data.
Delete Conditions

None : No deletion. The data is not deleted and remains in memory.
Not Locked : Deletes all data except data that is Locked.
All : Deletes all data.

Note: The Channel option is not available in Xiino English version.
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5.4 Certificates

5.4.1 Adding a Certificate

When an SSL website is being downloaded in Xiino resulting in encrypting the data, the
"certificate" of the SSL website which proves to be safe is issued and stored in Xiino
automatically.

5.4.2 Unrecognized Certificate

When a web site that uses a security certificate is not recognized, a Security Alert dialog is
indicated with the warning that Xiino DataServer could not be recognized.

If the Security Alert dialog is ignored when still online, the "unrecognized certificate" is stored in
Xiino. However, please be aware that the safety of communication is not secured nor
guaranteed. To avoid the feeling of insecurity, delete the "unauthorized certificate".

5.4.3 View Certificate
To view the contents, go to the third page of the "Prefs" dialog screen as follows:

1. From the "Options" menu, select "Prefs...".
2. On the bottom right corner of the dialog screen, tap the upside down triangle until you 3/3.

3. You will see a list of Certificates. Tap a certificate from the list, and then tap "Show..." button to

display view the contents of the Certificate.

5.4.4 Deleting a Certificate

Delete a Certificate from Prefs Dialog 3 when an "unauthorized certificate" is stored.

1. From the "Options" menu, select "Prefs...".

2. On the bottom right corner of the dialog screen, tap the upside down triangle until you 3/3.
3. You will see a list of Certificates. Tap a certificate from the list that you would like to delete,
and then tap "Delete..." button.
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6 Others

6.1 Troubleshooting
When Unable To Display Web Page

Web page does not display
Cause: Incorrect setting of the screen display.
Solution:  Confirm the following items in the “Settings” dialog box
*“Image Load”: Change to “Always” if it is set to “If Requested”
* “Proxy”: enter pds.ilinx.co.jp as the Proxy URL server
To display the “settings” dialog box, tap the “Menu” button on the “browse screen”
and select “Settings” from the “Option” menu.

It takes a long time to load a web page.
Cause: The web site or the proxy server is congested..
Solution:  Connect to another provider or access point. Or, try again later.

Web Pages are not loading.

Cause: The URL is not correct, or the URL does not exist.

Solution:  Confirm the input data when you enter a URL form the “Open URL” dialog box.
The following symbols are easily mistake:
* carat [*] and tilde [~]
* hyphen [-] and underscore [_]
* numerical zero [0] and alphabetical O [O]
When a URL is opened from “Bookmark” or “Cache”, it may not be displayed due
to a change or deletion of the URL. Input the entire link again from the start of the
URL, paying special attention to the domain ending (e.g. ~.com/ or ~.net/)

When Unable to Perform HotSync

After making a line connection, you cannot perform HotSync with the PC

Cause: HotSync cannot be performed while there is a line connection.

Solution:  If the telephone icon shows that the there is a line connection, disconnect. In other
cases, please refer to the operation manual of your Palm Device.

Please also check our FAQ pages at http://www.ilinx.co.jp/en/support/fag.html

6.2 Further information
Please refer to our web site at http://www.ilinx.co.jp/en/ for further details.
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6.3 End User License Agreement

END USER LICENSE AGREEMENT FOR XIINO ™ SOFTWARE

Before using the following software and related software (hereinafter referred to as "Software"), please read the following
documentation carefully.
Xiino 1.0E

Software and incorporated software in Software are protected by the Copyright Law, other intellectual property laws and
international treaties. ILINX™ Inc. (hereinafter referred to as "ILINX") holds and owns the copyright and the right to license
Software. Software includes third party's (hereinafter referred to as "Vendor") software that ILINX has legitimately been
granted a license to use.

The Software is licensed, not sold to you as long as you comply with the terms and conditions set forth in this Agreement.
Please note that you are not permitted to use Software if you don't agree to any and all provisions of this Agreement.

1. GRANT OF LICENSE

ILINX grants the right to use Software, in accordance to the provisions under this Agreement, to the first user who installs
Software on a Personal Digital Assistant (hereinafter referred to as "PDA") or to the first user of the PDA on which
Software is pre-installed.

2. RESTRICTIONS

2.1 You may install and use Software on only one PDA for ordinary use and in the form of object code.

2.2 You shall not make copies of Software in either electronic or hardware form except for initial installation on PDA,
loading into temporary memory or peripheral devices for ordinary use, or making backup copies. You shall not install on
two or more PDAs at the same time.

2.3 You shall not modify, translate or merge Software, analyze it by reverse engineering, decompile, disassemble, or
create derivative works in any form or by any means from the object code of Software.

2.4 This license Agreement does not permit the use of ILINX's trademark or service mark; therefore you may not remove,
change or obscure ILINX's indication or notice of copyright, trademark, or other proprietary rights.

3. OTHER RIGHTS GRANTED

You are not granted any patent, copyright, trademark, or other proprietary rights in whole or in part that ILINX owns on
Software, and shall not lease, transfer, distribute (including transmission through the Internet or other networks, and also
recording on the servers connected to the networks to make such transmission possible), or sublicense Software to a third

party.

4. TRANSFER OF LICENSE

4.1 You may transfer the right to use Software to a third party by assigning any and all rights and obligations under this
Agreement and 1) transferring in whole all types of medium, all copies in any form and documentations, or 2) transferring
them in part and completely destroying whatever was not transferred whether tangible or electrical. However, you agree
and certify that Software will not be exported except as authorized and as permitted by the laws and regulations of the
United States and other country in which you obtained Software and to which you intend to export and/or import the
Software. The same rule shall apply to the next third party who is in line to receive the transferred right.

4.2 In no way shall the copyright notice be changed or removed from Software and documentation be transferred.

4.3 If any condition in this Article is not fulfilled, the transfer of the right shall not be in effect.

5. TERM OF LICENSE
Your first use of any part of Software shall be regarded as your acceptance of the terms and conditions under this
Agreement and shall validate it at the same time.

6. YOUR PERSONAL DATA

You shall confirm and agree that ILINX may access to your personal data you have provided and registered to the Web
site from which you have downloaded the Software (hereinafter referred to as "Web site") to the extent of being necessary
for ILINX to provide you some kinds of services related to the Software. Web site may disclose such information to ILINX
and ILINX may register it as its "Customer Information”. Based on registered Customer Information, ILINX may provide
you support service and/or any other services specified by ILINX. You may request to confirm, revise or delete your
personal data registered to ILINX, subject to proving your identification.

7. LIMITED WARRANTY ON PAID-UP SOFTWARE

ILINX's warranty and liability on the Software you have paid up for shall be as follows:

7.1 ILINX warrants that for a period of ninety (90) days from the date of delivery of the licensed Software, it will replace or
repair within its discretion, the media and related documentations provided by ILINX , if there are any defects on them.
THESE WARRANTIES REPLACE ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE.

7.2 THIS SOFTWARE DOES NOT HOLD DURABILITY AGAINST PHYSICAL INCIDENTS OR MECHANICAL FAILURE
AND IS NOT INTENDED FOR USE IN HIGHLY STABLE AND SECURE ENVIRONMENTS. ILINX OR VENDOR DOES
NOT WARRANT THAT; SOFTWARE WILL MEET EACH USER'S REQUIREMENTS; SOFTWARE INSTALLED ON PDA
WILL WORK COMPLETELY WITH OTHER INSTALLED SOFTWARE ON SUCH PDA; OPERATION OF SOFTWARE
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WILL BE UNINTERRUPTED; DURING CONNECTION WITH THE INTERNET OR OTHER NETWORKS, SOFTWARE
WILL BE ERROR-FREE AND WILL NOT DAMAGE HARDWARE, SOFTWARE, AND DATA CONNECTED WITH SUCH
NETWORKS; OR SOFTWARE WILL NOT EFFECT YOUR OR THIRD PARTY'S ELECTRONIC INFORMATION IN ANY
WAY.

7.3 IN NO EVENT SHALL ILINX NOR VENDOR BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR
INDIRECT DAMAGES, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION/DATA, OR ANY OTHER PECUNIARY LOSS
ARISING OUT OF THE DISTRIBUTION, INSTALLATION, MAINTENANCE, USE OR INABILITY TO USE INCLUDING
THE INTERRUPTION OF SOFTWARE IMPLEMENTATION RELATED TO THIS AGREEMENT. IN NO EVENT SHALL
ILINX'S NOR VENDOR'S TOTAL LIABILITY TO YOU FOR ALL DAMAGES, LOSSES, AND CAUSES OF ACTION
(WHETHER IN CONTRACT, TORT, OR OTHERWISE) EXCEED THE AMOUNT OF LICENSE FEE PAID BY YOU FOR
THE SOFTWARE, PROVIDED THAT SUCH LIMITATION OF LIABILITY MAY NOT APPLY TO YOU IF THE DAMAGES,
LOSSES OR CAUSES OF ACTION WHICH ARE CAUSED BY INTENTIONAL ACT OR GROSS NEGLIGENCE OF
ILINX OR VENDOR.

7.4 ILINX or Web site may provide you some additional free services including information transmission service through
ILINX the server managed by ILINX or Web site. IN THIS CASE, ILINX AND/OR WEB SITE SHALL NOT WARRANT
ANYTHING RELATED TO SUCH SERVICES AND SHALL NOT BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
CONSEQUENTIAL, OR INDIRECT DAMAGES OR LOSS OF PROFITS, CAUSED BY OR RELATED TO THE
SERVICES, PROVIDED THAT THE DAMAGES OR LOSSES ARE NOT CAUSED BY INTENTIONAL ACT OR GROSS
NEGLIGENCE OF ILINX OR WEB SITE.

8. LIMITED WARRANTY DURING TRIAL USE TERM

ILINX's warranty and liability during the trial use term of the Software shall be as follows:

8.1 User support by ILINX shall not be available.

8.2 ILINX SHALL NOT WARRANT ANYTHING RELATED TO THE SOFTWARE, WHETHER EXPRESS OR IMPLIED.
8.3 IN NO EVENT SHALL ILINX BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR INDIRECT
DAMAGES OR DAMAGES FOR LOSS OF BUSINESS PROFITS ARISING OUT OF THE DISTRIBUTION,
INSTALLATION, MAINTENANCE, USE OR INABILITY TO USE INCLUDING INTERRUPTION OF SOFTWARE
IMPLEMENTATION OR RELATED TO THIS AGREEMENT, PROVIDED THAT THE DAMAGES OR LOSSES ARE NOT
CAUSED BY INTENTIONAL ACT OR GROSS NEGLIGENCE OF ILINX.

8.4 ILINX or Web site may provide you some additional free services including information transmission service through
the ILINX server managed by ILINX or WEB Site. IN THIS CASE, ILINX AND/OR WEB SITE SHALL NOT WARRANT
ANYTHING RELATED TO SUCH SERVICES AND SHALL NOT BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
CONSEQUENTIAL, OR INDIRECT DAMAGES OR LOSS OF BUSINESS PROFIT CAUSED BY OR RELATED TO THE
SERVICES, PROVIDED THAT THE DAMAGES OR LOSSES ARE NOT CAUSED BY INTENTIONAL ACT OR GROSS
NEGLIGENCE OF ILINX OR WEB SITE.

9. TERMINATION OF LICENSE

9.1 This Agreement and your rights hereunder shall automatically terminate if and when you 1) fail to comply with any
provision of this Agreement, 2) transfer the right to use Software to a third party according to this Agreement, or 3) destroy
Software and all its copies and related documentation.

Upon termination, you shall cease any and all use of Software and destroy all copies including written documentation and
modified copies, if any.

9.2 ILINX may provide you free upgrade version of the Software (miner change version having the same integer version
number as the original version) subject to your registration to ILINX. In this case your license on the old version of the
Software will terminate at the time when you agree END USER LICENSE AGREEMENT for upgrade version by way of
acquiring and commencing the use of it. After that you shall not use or transfer the old version and you shall destroy any
and all old version and its manual.

10. RIGHTS AGAINST INFRINGEMENT

In the event you are reasonably assumed to have infringed any provision under this Agreement, ILINX shall reserve the
right to 1) make an on-site-search of the premises, where you are reasonably assumed to hold any media or copies of
Software, to find any facts related to the infringement, and 2) browse, make copies and/or take photos of the related
materials.

On finding the fact of your infringement, ILINX shall have the right to prohibit your use of Software and claim the indemnity
for any direct or indirect damages incurred by the infringement.

ILINX shall not be liable for any property or psychological damages to you resulting from the search, even if your
infringement is not found.

11. GOVERNING LAW AND PRIMARY COURT

This Agreement shall be governed and construed in accordance with Japanese laws. ILINX and you submit to the non-
exclusive jurisdiction of the Tokyo District Court in Japan with respect to all dispute arising from the interpretation and
performance of this Agreement, wherever the parties' venues or places of disputes are located and regardless to the
amount in dispute. Each party hereby agrees to waive its right to demand a jury trial for any cause of action.

12. AMENDMENT

ILINX may notify you the amendment of this Agreement by sending E-mail or any other appropriate means. In such case,
the offered amendment shall be regarded as accepted by you unless you make any objection in writing no later than
fourteen (14) days after receipt of ILINX's naotification.

Xiino 1.0 English User Manual 31
© 2002 ILINX, Inc.



13. SERVERABILITY
Should any provision of this Agreement be or become illegal, invalid or unenforceable, the legality, validity, and
enforceability of the remaining provisions of this Agreement shall not be affected or impaired thereby.

14. ENTIRE AGREEMENT
This Agreement is the entire Agreement to date between you and ILINX, and supersedes any such prior written or oral
agreement regarding Software.

15 US GOVERNMENT RESTRICTED RIGHTS

If Software is acquired under the terms of a proposal or agreement with the United States Government or any contractor
thereof, Software is subject to the following: (a) For acquisition by or on behalf of civilian agencies, as necessary to obtain
protection as "commercial computer software" and related documentation in accordance with the terms of this
Commercial Software Agreement as specified in 48 C.F.R. 12.212 of the Federal Acquisition Regulations and its
successors; (b) For acquisition by or on behalf of units of the Department of Defense ("DOD") as necessary to obtain
protection as "commercial computer software" and related documentation in accordance with the terms of this commercial
computer software license as specified in 48 C.F.R. 227-7202-2 of the DOD F.A.R. Supplement and its successors.

Palm is a registered trademark of Palm Inc.
Xiino and ILINX are trademarks of ILINX Inc.
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